LAMPIRAN

Programable

#include <LiquidCrystal_12C.h>
LiquidCrystal_I2C lcd(0x27 ,2,1,0,4,5,6,7,3, POSITIVE);

#define RELAY_ONO

#define RELAY_OFF 1

#include "DHT.h"

#define DHTPIN_19 // pin for data
#define DHTPIN_2 7

#define DHTTYPE DHT22 // type sensor

DHT dht1(DHTPIN_1, DHTTYPE); // initializes sensor
DHT dht2(DHTPIN_2, DHTTYPE); // initializes sensor

int RELAY_1 =8;

int RELAY 2 =12;

int led_pin = 13;

int chk;

float hum1, /I stores humidity
float suhu, suhu_2;; // stores temperature
float humz2; /I stores humidity

// Program: Sound Level Measurement

int num_Measure = 128 ; // Set the number of measurements
int pinSignal = AO;  // pin connected to pin O module sound sensor

long Sound_signal; /I Store the value read Sound Sensor
longsum=0; /I Store the total value of n measurements
long level =0 ; /I Store the average value

/#include <RBDdimmer.h>//

/#define zerocross 2 // for boards with CHANGEBLE input pin

int AC_LOAD =3; // Output to Opto Triac pin

int dimming=128; // Dimming level (0-255) 0 = ON, 255 = OFF

float keluaranl;

float a,b,c;

float member_suhu;

float member_kelembaban;

float dingin, sejuk, normal, panas, sangatpanas;

float dingin2, sejuk2, normal2, panas2, sangatpanas_2;

float min1, min2, min3, min4, min5, min6, min7, min8, min9, min10,
minll,min12, minl13, minl4, minl5, minl6, minl17, min18, min19, min20,
min21,min22, min23, min24, min25;
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int PD=0, PL=65, NR=125, CP=175, SC=255;

floatA,B,C,D,E,F,G,H, I,J,K,L,M,N,O,P,Q,R,S, T,U, VW, X, Y;
float output=0;

float crispy;

unsigned long interval=1000;  // the time we need to wait

unsigned long previousMillis=0; // millis() returns an unsigned long.

/I definis pin unutuk relay heatern dan valve juga led
#define temppeste A3
#define umidpeste A2

/I definisi variable
float te, t1, tes, dete;  // variable untuk temperature
int has, hass, dehas; /[ variable untuk humiditiy

#tdefine BUT1 6 // - switch
#define BUT2 11 // + switch
#define BUT3 10 // MENU switch

byte meniu = 0; // if MENIU = 0 untuk clasical
// if MENIU = 1 untuk temperature set (tes)
/[ if MENIU = 2 untuk dt temperature (dete)
// if MENIU = 3 untuk humidity set (hass)
/[ if MENIU = 4 untuk dh humidity (dehas)
byte grad[8] = {
B01100,
B10010,
B10010,
B01100,
B0000O,
B0000O,
B0000O,

b
void setup()

Serial.begin(9600);
// Initialize LCD display
Icd.begin(20, 4);
/I create custom simbol
Icd.createChar(0, grad);

/I definisi output
pinMode(temppeste, OUTPUT);
pinMode(umidpeste, OUTPUT);

/I atur status default untuk output
digitalWrite(temppeste, LOW);
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digitalWrite(umidpeste, LOW);

/I mengatur tombol untuk menu
pinMode(BUT1, INPUT);
pinMode(BUT2, INPUT);
pinMode(BUT3, INPUT);

digitalWrite(BUT1, HIGH); // pull-up aktif
digitalWrite(BUT2, HIGH);
digitalWrite(BUT3, HIGH);
Icd.setCursor(0,0);

Icd.print("monitoring™);

Icd.setCursor(0,1);
Icd.print("inkubator bayi");

Icd.setCursor(0,2);
Icd.print("'set poin suhu™);

Icd.setCursor(0,3);
Icd.print("dan kelembaban ");

delay(3000);
Icd.clear();

/I nilai yang telah ditetapkan untuk suhu dan kelembaban
tes = 35;

dete = 0.2;

hass = 65;

dehas = 2;

Serial.begin(9600);
dhtl.begin();
dht2.begin();
pinMode (pinSignal, INPUT); // Tetapkan pin sinyal sebagai input
pinMode(led_pin,OUTPUT);
Il Set pin output.
pinMode(RELAY_1, OUTPUT);
/I Set pin output.
pinMode(RELAY_2, OUTPUT);
/I Inisialisasi relai sebagai mati sehingga saat disetel ulang akan mati secara
default
digitalWrite(RELAY _1, RELAY_OFF);
digitalWrite(RELAY_2, RELAY_ON);
digitalWrite(13, HIGH);

Icd.begin(20, 4);
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Icd.setCursor(2,0);
Icd.print("Di Buat Oleh™);
Icd.setCursor(2,1);
Icd.print("kuat );
delay(3000);

Icd.clear();

pinMode(AC_LOAD, OUTPUT);// Tetapkan pin Muat AC sebagai output // pwm
attachlInterrupt(0, zero_crosss_int, FALLING); //pin d2
Serial.begin(9600);

}

void zero_crosss_int()

{

int dimtime = (35*dimming); // untuk 60Hz =>65
delayMicroseconds(dimtime); // Off cycle
digitalWrite(AC_LOAD, HIGH); /I triac firing
delayMicroseconds(10);

digitalWrite(AC_LOAD, LOW); // triac Off

}
void loop()

{

unsigned long currentMillis = millis(); // grab current time
if ((unsigned long)(currentMillis - previousMillis) >= interval) {

hum1 = dhtl.readHumidity(); / membaca dan menyimpan hum
suhu= dhtl.readTemperature(); // membaca dan menyimpan temp
hum2 = dht2.readHumidity(); /l membaca dan menyimpan hum
suhu_2= dht2.readTemperature(); // membaca dan menyimpan temp

keluaranl = output;
dimming=Kkeluaranl;

crispy = map(dimming, 0,255,255,0);
membership();

defuzifikasi();

Output();

tampilan();

previousMillis = millis();

// baca input pada pin analog 0
int sensorValue = analogRead(A0);

for (inti=0;1<num_Measure; i ++)
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{
Sound_signal = analogRead (pinSignal);

sum =sum + Sound_signal;

¥

level = sum / num_Measure; // Hitung nilai rata-rata
sum=0; /I Atur ulang jumlah nilai pengukuran
delay(50);

/[ perintah pada relay valve
if (sensorValue <58)// ON

{digitaIWrite(RELAY_l, RELAY_ON);
' digitalWrite(13, HIGH);

else if (sensorValue >59)//OFF
{digitaIWrite(RELAY_l, RELAY_OFF);
digitalWrite(13, LOW);

if (hum2 <70)// ON

digitalWrite(RELAY_2, RELAY_ON);

e

else if (hum2 >71)//OFF

digitalWrite(RELAY_2, RELAY_OFF);

= o~

/menampilkan informasi kelcd
Icd.setCursor(0,2);
lcd.print("Hum:");
Icd.print(hum1);
Icd.setCursor(10,2);
Icd.print("C Out:");
Icd.print(suhu_2);
Icd.setCursor(10,3);
lcd.print("C In :");
Icd.print(suhu);
Icd.setCursor(0,3);
lcd.print(" dB: ");
Icd.print(sensorValue);

}

|[==== == == === =program
setpoin::::::::::::::::::::::::::::::::::::::
if (digitalRead(BUT3) == LOW)
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{ meniu = meniu + 1;
Icd.clear();
delay(250);

¥

if (meniu >=5) meniu = 0;
if (meniu ==0)

if (digitalRead(BUT3) == LOW)
{ meniu =1;

delay(250);

¥

// Suhu atau kelembaban membaca
has = dhtl.readHumidity();

te = dhtl.readTemperature();
delay(500);

Icd.setCursor(0, 0);
I/ lcd.print("t=");
if (te <0)
{t1=-te;}

else tl=te;

if (1< 10)

lcd.print(" ™);

}
if (te>0) lcd.print("+");
if (te==0) lcd.print(" ");
if (te<0) Icd.print("-");
Icd.print(t1,1);

/I lcd.write(0b11011111);
Icd.write(byte(0));
Icd.print("C ");

Icd.setCursor(12, 0);
Il lcd.print("H=");
Icd.print(has);
Icd.print("%RH");

if (te > tes)

{

digitalWrite(temppeste, LOW);
Icd.setCursor(0, 1);
Icd.print("melebihi *');

}
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if (tes - dete > te)
{
digitalWrite(temppeste, HIGH);
Icd.setCursor(0, 1);
Icd.print(""kurang");

}
if ((te <=tes) and (tes - dete <= te))

Icd.setCursor(0, 1);
Icd.print("pas ! ");

if (has > hass)

{

digitalWrite(umidpeste, HIGH);
Icd.setCursor(12, 1);
Icd.print("melebihi ");

¥

if (has < hass - dehas)

digitalWrite(umidpeste, LOW);
Icd.setCursor(12, 1);
Icd.print("kurang");
}
if ((has <= hass) and (has >= hass - dehas))
{ lcd.setCursor(12, 1);
Icd.print("pas ! ");

}
} // last line for MENIU =0

if (meniu==1) {

while (meniu==1) {

Il teset(tset);
Icd.setCursor(0, 0);
Icd.print("Temperature SET:");
Icd.setCursor(0, 1);

/Il lcd.print("+");
Icd.print(tes,1);

/I lcd.write(0b11011111);
Icd.write(byte(0));
Icd.print("C );

Icd.setCursor(8, 1);
Icd.print("dt=");
Icd.print(dete,1);

/I lcd.write(0b11011111);
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Icd.write(byte(0));
Icd.print("C );

if (digitalRead(BUT1) == LOW)
{tes=tes-0.1;
delay(250);

if (digitalRead(BUT2) == LOW)
{tes=tes +0.1;

delay(250);

¥

if (digitalRead(BUT3) == LOW)
{ meniu =2;

delay(250);

Icd.clear();

}
/I delay(15);

}
delay (100);

} //end loop for MENIU =1

if (meniu ==2) {

[ if (tmax <= tmin) tmax = tmin + 10;

while (meniu ==2) {
Icd.setCursor(0, 0);
Icd.print("hyst.temp. SET:");
Icd.setCursor(0, 1);

/I lcd.print("+");
Icd.print(tes,1);

/I lcd.write(0b11011111);
Icd.write(byte(0));
Icd.print("C ");

Icd.setCursor(8, 1);
lcd.print("dt=");
Icd.print(dete,1);

/I lcd.write(0b11011111);
Icd.write(byte(0));
Icd.print("C ");

if (digitalRead(BUT1) == LOW)
{ dete = dete - 0.1;
delay(250);

if (digitalRead(BUT2) == LOW)
{ dete = dete + 0.1,
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delay(250);

if (digitalRead(BUT3) == LOW)
{ meniu = 3;
delay(250);
Icd.clear();
}
/I delay(15);
if (dete <0.1) dete =0.1;

b
} //'end loop for MENIU = 2

if (meniu ==3) {

while (meniu == 3) {

Il teset(tset);
Icd.setCursor(0, 0);
Icd.print("Humidity SET:");
Icd.setCursor(0, 1);

Il lcd.print("+");
Icd.print(hass,1);

/I lcd.write(0b11011111);

/Il lcd.write(byte(0));
Icd.print("%RH *);

Icd.setCursor(7, 1);
Icd.print("dh=");
Icd.print(dehas);
/I lcd.write(0b11011111);
/Il lcd.write(byte(0));
Icd.print("%RH");

if (digitalRead(BUT1) == LOW)
{ hass = hass - 1;

delay(250);

¥

if (digitalRead(BUT2) == LOW)
{ hass = hass + 1;

delay(250);

¥

if (digitalRead(BUT3) == LOW)
{ meniu =4;

delay(250);

Icd.clear();

}
/I delay(15);
}
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delay (100);
} // end loop for MENIU =3

if (meniu==4) {
while (meniu ==4) {
Icd.setCursor(0, 0);
Icd.print("hyst.humid. SET:");
Icd.setCursor(0, 1);

/I lcd.print("+");
Icd.print(hass);

/I lcd.write(0b11011111);
Icd.write(byte(0));
Icd.print("%RH");

Icd.setCursor(7, 1);
Icd.print("dh=");
Icd.print(dehas);

/I lcd.write(0b11011111);
Icd.write(byte(0));
Icd.print("%RH"™);

if (digitalRead(BUT1) == LOW)
{ dehas = dehas - 1;
delay(250);

¥

if (digitalRead(BUT2) == LOW)
{ dehas = dehas + 1;

delay(250);

¥

if (digitalRead(BUT3) == LOW)
{ meniu =5;

delay(250);

Icd.clear();

}
/I delay(15);

if (meniu ==5) {
while (meniu ==5) {

Il teset(tset);
Icd.setCursor(0, 0);
Icd.print("Temperature SET:");
Icd.setCursor(0, 1);

Il lcd.print("+");
Icd.print(tes,1);

/I lcd.write(0b11011111);
Icd.write(byte(0));
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Icd.print("C ™);

Icd.setCursor(8, 1);
Icd.print("dt=");
Icd.print(dete,1);

/I lcd.write(0b11011111);
Icd.write(byte(0));
Icd.print("C ");

if (digitalRead(BUT1) == LOW)
{tes=tes-0.1;
delay(250);

if (digitalRead(BUT2) == LOW)
{tes=tes +0.1;

delay(250);

¥

if (digitalRead(BUT3) == LOW)
{ meniu = 6;

delay(250);

Icd.clear();

}
/I delay(15);

}
delay (100);
} //endloop for MENIU =1

if (meniu ==6) {

[ if (tmax <= tmin) tmax = tmin + 10;
while (meniu ==6) {

/[ maxim(dt/10); // this is number to diplay

/I dete(dt); // this is number to diplay
Icd.setCursor(0, 0);
lcd.print("hyst.temp. SET:");
Icd.setCursor(0, 1);

Il lcd.print("+");
Icd.print(tes,1);

/I lcd.write(0b11011111);
Icd.write(byte(0));
Icd.print("C ");

Icd.setCursor(8, 1);
Icd.print("dt=");
Icd.print(dete,1);

/I lcd.write(0b11011111);
Icd.write(byte(0));
lcd.print("C ");
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if (digitalRead(BUT1) == LOW)
{ dete = dete - 0.1,
delay(250);

if (digitalRead(BUT2) == LOW)
{ dete = dete + 0.1;
delay(250);

if (digitalRead(BUT3) == LOW)
{ meniu=7;

delay(250);

Icd.clear();

¥
/I delay(15);
if (dete <0.1) dete =0.1;

}
} //'end loop for MENIU =2

if (dehas < 1) dehas = 1;
}
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{

A =minl1*PD; B = min2*PD; C = min3*PL; D = min4*NR; E = min5*CP;

F = min6*PD; G = min7*PL; H = min8*PL; | = min9*NR; J = min10*CP;

K =minl11*PL; L = min12*PL; M = min13*NR; N = min14*CP; O = min15*SC;
P =minl6*NR; Q = min17*NR; R = min18*CP; S = min19*SC; T = min20*SC,;
U = min21*CP; V = min22*CP; W = min23*SC; X = min24*SC; Y = min25*SC;
output=(A+B+C+D+E+F+G+H+1+J+K+L+M+N+O+P+Q+
R+S+T+U+V+W+X+Y)/(minl+ min2 + min3 + min4 + min5+ min6 +
min7 + min8 + min9 + min10 + min1l + min12 + min13 + min14 + min15 +
minl6 + minl7 + min18 + minl19 + min20 + min21 + min22 + min23 + min24 +
min25);

void tampilan()

{

[* Serial.print("DHT22_1: ");
Serial.print("huml1 =");
Serial.print(hum1);
delay(1000);*/
Serial.print("suhu dalam=");
Serial.print(suhu);
Serial.printin(" C");
delay(1000);
[*Serial.print("DHT22_2: "™);
Serial.print("hum2 =");
Serial.print(hum2);
delay(1000);*/
Serial.print(""suhu luar=");
Serial.print(suhu_2);
Serial.printin(" C");
delay(1000);
Serial.print(""suhu dalam=");
Serial.print(suhu);
Serial.printin(" C");
delay(1000);

Serial.print("*'sound: ");
Serial.print(level);
Serial.printin(* dB");
//Serial.print(" | ");
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delay(1000);
[*Serial.print("hyst C: ");
Serial.print(dete);
delay(1000);
Serial.print("|setpoin C: ™);
Serial.print(tes);

delay(1000);
Serial.print("|hyst %: ");
Serial.print(dehas);

delay(1000);
Serial.print("|setpoin %: ");
Serial.print(hass);

delay(1000);
/*Serial.print("|temperature C: ");
Serial.print(te);

delay(1000);*/
Serial.print("kelembaban %: ");
Serial.printin(has);
delay(1000);

[*Serial.print("SUHU 1=");
Serial.print(suhu);
Serial.print("*C");
delay(1000);
Serial.print(" | ");
Serial.print("SUHU 2=");
Serial.print(suhu_2);
Serial.print("*C");
delay(1000);
*/
/Serial.print(*" | );
Serial.print("Fuzzy output:");
Serial.print( output);
Serial.printin(" ");
delay(1000);
Serial.print("Crisp output:");
Serial.print( crispy);
Serial.printin(" ");
delay(1000);

void membership()

{
I[fuzzyfikasi
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//SENSOR suhul

member_suhu = 0;

Sensor_1(a=0, b=30, ¢=35); //Buat Dingin
dingin = member_suhu;

Sensor_1(a=30, b=35, c=40); //Buat Sejuk
sejuk = member_suhu;

Sensor_1(a=35, b=40, c=45); //Buat Normal
normal = member_suhu;

Sensor_1(a=40, b=45, ¢c=50); //Buat Panas
panas = member_suhu;

Sensor_1(a=45, b=50, c=55); //Buat Sangat Panas

sangatpanas = member_suhu;

//ISENSOR kelembaban
member_kelembaban = 0;

Sensor_1(a=0, b=15, ¢=35); //Buat sangat kering
dingin2 = member_kelembaban;
Sensor_1(a=15, 35, c=45); //Buat kering
sejuk2 = member_kelembaban;
Sensor_1(a=35, b=45, ¢=65); //Buat normal
normal2 = member_kelembaban;
Sensor_1(a=45, b=65, c=70); //Buat lembab
panas2 = member_kelembaban;
Sensor_1(a=65, b=70, c=80); //Buat Sangat lembab
sangatpanas_2 = member_kelembaban;
Ifuzzyfikasi

minl = min(dingin, dingin2);

min2 = min(dingin, sejuk?);

min3 = min(dingin, normal?2);

min4 = min(dingin, panas2);

min5 = min(dingin, sangatpanas_2);

min6 = min(sejuk, dingin2);

min7 = min(sejuk, sejuk2);

min8 = min(sejuk, normal2);

min9 = min(sejuk, panas2);

minl0 = min(sejuk, sangatpanas_2);

minll = min(normal, dingin2);

minl2 = min(normal, sejuk?2);

minl3 = min(normal, normal2);

minl4 = min(normal, panas2);

minl5 = min(normal, sangatpanas_2);
minl6 = min(panas, dingin2);

minl7 = min(panas, sejuk?2);

minl18 = min(panas, normal2);

minl9 = min(panas, panas2);

min20 = min(panas, sangatpanas_2);
min21 = min(sangatpanas, dingin2);

min22 = min(sangatpanas, sejuk?);

87



min23 = min(sangatpanas, normal2);
min24 = min(sangatpanas, panas2);
min25 = min(sangatpanas, sangatpanas_2);

}
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|| ================ —==== == Rule Base

void Output ()
{

it (output < 32) { Serial.print("SANGAT DINGIN");}

if (output >= 33 && output < 65) {Serial.print("DINGIN");}

If (output >= 65 && output < 125) {Serial.print("AGAK HANGAT");}
if (output >= 125 && output < 142) {Serial.print("HANGAT");}

if (output >= 142 && output < 256) {Serial.print("PANAS");}

/1if (output > 255) { output = 255; Serial.print("SANGAT CEPAT ");}
Serial.printin();

float Sensor_1(float a, float b, float c)
{
if ((suhu >= a) && (suhu < b))

member_suhu = (suhu - a) / (b - a);

¥
if ((suhu >=b) && (suhu < ¢))

member_suhu = (¢ - suhu) / (c - b);
}

if ((suhu <0) || (suhu > 100))

{

member_suhu =1,

}
if ((suhu > c) || (suhu < a))

member_suhu = 0;

¥
if (hum1>=a) && (huml< b))

{

member_kelembaban = (hum1-a) / (b - a);

}
if (hum1>= b) && (humi< c))
{

member_kelembaban = (c - hum1) / (c - b);

}
if ((hum1< 0) || (hum1> 100))

member_kelembaban = 1;

¥
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if (hum1>c) || (huml< a))

member_kelembaban = 0;

¥
}
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AC Light Dimmer Modul

RobotOyn Q

AC Light Dimmer Module, 1 Channel, >
3.3V/5V logic, AC 50/60hz, 220V/110V

LA B A & Be the first to review this product

The AC Dimmer is designed to control the alternating current voltage, which can

transfer current up to 600V/16A,

33.49 Availability: In stock

SKU#: 5352d452-¢6¢8-11e6-ab3¢c-10c37b90f38d

Buy 5 for 5329 each and save 6%
Send message
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General information

The AC Dimmer is designed to control the alternating current voltage, which
can transfer current up to 600V/16A. In most cases, Dimmer is used to turn
power ON/OFF for lamps or heating elements, it can also be used in fans,
pumps, air cleaners, e.t.c.

Lately, Dimmer has become an often used decision for the smart home
systems. For example, when you need to smoothly change the light brightness.
The lamp s slowly turning ON or OFF, creating a comfortable atmosphere.
Dimmer works most effective with filament lamps. It's less stable with low
brightness LED lamps, but with moderate and high brightness it will perform
a solid job. Note that luminescent lamps (gas discharge lamps) do not support
dimming.

Power part of dimmer is isolated from the control part, to exclude the
possibility of high current disruption to a microcontroller.

The logical level is tolerant to SV and 3.3V, therefore it can be connected to the
microcontroller with 5V and 3.3V level logic.

In Arduino, dimmer is controlled with RBDdimmer.h library, which uses
external interrupts and process time interrupts. it simplifies the code writing
and gives more processing time for main code. Which is why you can control
multiple Dimmers from one microcontroller.

You can download RBDDimmer.h library and a few examples in «Documentss
or on GitHub. We are constantly updating our library, so we recommend

to check for the website updates or subscribe to our newsletter.

Dimmer Is connected to Arduino controliers via two digital pins. First (Zero)

to control the passing of Phase Null of AC, which is used to initiate the interrupt
signal. Second (DIM/PSM) to control (dim) current.

Note that Zero requires connection to designated microcontroller pins (which
are different depending on the model of Uno, Nano, Leonardo, Mega), since

it tied to microcontroller interrupts.
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AL Light Benmer Modide. 1 Chamnel, 3 VSV loge, AL 50800, 2200/ 110V, compaiible with Ardamo DE
Dimming can be achieved by Pulse Skip Modulation:

* Method 1 — One or more cycles (sine wave signal) are transferred to the
load, while following one or several cycles are blocked.

e Method 2 — Partial transferrence of each sine wave to the load.

e Method 3 — Generation of modulated full sine signal of different
frequency up to few hundred hertz. This method requires spedialized
powerfull AC generators with different modulation.

Methods 1 and 2 are the easiest to execute with the help of a Dimmer and
programm code: in both cases, there is a need of circuit that detects the zero
crossing and can control a triac.

ATENTION:

We do not recommend to use dimmer with LED, luminescent lamp or any
other lamp with built-in brightness regulator!

WE FOUND OTHER PRODUCTS YOU MIGHT LIKE! 000
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Analog Slide Position - Potenti... Rotation potentiometer (anal... Buttor
$1.39 $0.99 As

‘RoboMn

CONTACT INFORMATION

CHINA

2 East Gate, 6/B, Sth East Nanping Rd., Nanping Industrial Park, Xiangzhou District, Zhuhai, GD, China
PHONE

+86-756-3358590

RUSSIA

Varshavskoe shosse, 42, Moscow, Russia

PHONE

+7-499-110-24-82

f

SUBSCRIBE TO NEWSLETTER

Stay for updates
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Sound sensor Arduino

Tuesday, April 19, 2016 ;
Sound sensor Arduino

Tutorial on how to interface sound sensor with Arduino. More precisely, Sound Sensor. | will show how to detect
ambient sound and how to handle the signal generated by this module. This board along with the microphone,
has a small built-in amplifier (integrated circuit LM386), because only the microphone would not be able to send
data for Arduino. The connection scheme is very clean, composed of only 3 pins: Vcc, GND and S (signal). In the
middle of the plate, there is a potentiometer for sensitivity adjustment.

The board works with 5V voltage, and the signal pin should be connected preferably to an analog port of
Arduino, since the generated signal is variable, and thus we can see the different levels of noise picked up by
the microphone. The circuit tests will consist of the module Sound Sensor , plus the display 16x2 LCD , which
wo've covered here on the site, in this article . If you do not have this display, do not worry because the program
is oasily adaptable to other models of LCD displays . The display at its top, will show the sound level (Low,

Medium and High), and bottom , a bar that will follow in real time the sound level detected by the microphone
will be shown:
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Sensor DHT 22 (DHT 22 also named as AM 2302

Aosong Electronics Co.,Ltd
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DHT22 (DHT22 also named as AM2302)

Capacitive-type humidity and temperature module/sensor

Phomnas L (Husiswss Masager |
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1| Fessue & Applicsion

* Full mnge temperature compensatied ¢ Relative hunudnty and tempensure measusement

* Calibrated digital cgnal  "Outatandiog loag tem sabdity  *loam v e not ot

* Lomg wansmission dstasce * Low power consumption *3 pins packaged and fully meerchangeable

2. Description:

DHT22 owput calibrated dgnal sipmal It unlizes exclusive dignal-segnal-collecung-techongoe and  humudity
scanmg techaclogy, assuring s relmbibity and sabday s sensing clements s commecsed with S-bu sagle-chip
comgnter

Every semor of this model & semperature compensated and calibvaied in poowme cabibention chamber and the
calibranon-coeflicient & saved in type of programme in OTP memory, when the semsor s detecthimg, it will coe
coetficient fram mesnory

Small sue & low consumptios & long wansmission detancel 2m) enabile DH 22 0 be suited i all kinds of
harsh apphication occasions

Snglevow packaged with foer pins, making the connection very coavenicnt

3. Technical Specification:
-
ka i k k-‘e D0
ul 8 1 via single-bus
b sl ol Ve r B
T - S0 ML elsiua ‘

Accuracy humidaty +- 2R H Max =-S%RH).  emgeratire < +0 SCelsius

Tm‘mw‘ .l S TI N Soun

4. Dimenslons: (unit-—mm)
1) Small size dimensions: (unit—mm)
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S. Electrical connection diagram:

DHT22 o
M C U A 2Pin

GND
IPl-==NC, AM23I02 = ssother nasse lor DT

6. Operating specifications:

(1) Power and Plas

Power's voltage should be 3.3-6V DC. When power ts supplied fo seassor, doa't send any instruction 1o the sensor
within one second © puss unstable statss. One capacitor valued 100nF cam be added between VDD and GND fe
wave fllsering,

(2) Communication snd signsl

Simghe-beas data is used Tor conumancanion berween MUL pnd DHIT22, it costs SmS for single ume
Curnamncalion

Data s comprsed of saegral and decimal part, the followesg o the furmuls for data
IVHT22 sond ost higher data bit fiostly!
DATA=K but ntegral RH data 8 but docimal RH datas 8 bt intogral T data+ ¥ bit decimal T data+ 8 bat chock-sum

I e data trasssmussion is right, chock sum should be the Last § bt of " bt maegrad RH data+K but decunal RH
data+ X bat integral T datae N it decemul T dats”

When MOU send st signal, DHT2 change fom low -pow et < onsumpton. mode 10 russmg-mode. Whes MO
Fiishs sending the stant sgeal, DHTZY will send respossse sigaal of 40-nt data that reflect the relative humidiry
)

hotnas L (Husssoss Masager)
el thownasliu F9S | RO yahoo com cn
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Uoad a3t 31 swnVaseg Ranally & 1S2guiatas aneen
and temperatare information to MCU. Withost stan sagsal from MCU, DHT22 wall sot give resposse signal o
MCU. Ose start signal for one time's response dass that reflect the refative humidity and temperasare infonmation
from DHT2Y. DHT22 will change 1o low-power-cosssmphion-mode when data collecung fimish if #t dont seceive
stant sigmal from MCU aguin.
1) Check bellow pucture for overall communication process:

Hoat computes send out
slatt wearal Dt wamaemssoon fnubed,
weed o wand KL pradl wp bes's voluge

LRl LY
— e
Lnas ey \
Nllup-l Hhoets *Muwd L-hlhl'l' \ \
Scrnmm pull doran
Mapuﬁc by volags
waly fow seman's outpul

SR bu

2) Siep 1 MOU send out sant signal o DIHT22

Dara-bes's free sasses 8 high woltage bevel. When consmunscanon herween MO and DHT22 begm, program of
MUOU will sransforms data-bus's voltage leved from high o low level and this process must beyond ot least T 10
eomre DHTL2 could detert MOLUs sigmal, then MOU will war 20030us for DTS response

Check bellow pacture for siep |

Phomnas L (Huseoss Masager)

Fanael (oo b RS | RGd yabsoo com on

100




Arduino Mega

Arduino MEGA 2560

.
5
.
:
.
.
.
»

ARDUTNO

W ANALLC I ’
i1 9333337 %=

The Arduing Mega 2580 = a miccconbroller board based on the ATmega2S80
(dataghesl) # has 54 digited mputioutput pins (of which 14 can be used as PWM outputs)
16 anslog inputs, 4 UARTs (hardware senal ports), a 18 MMz crystal oscllator, @ USB
comecton, a power jack, an ICSP header, and a reset button & contains everything
needed %0 support the microcontroller, simply connect il to & computer weih a USB cable or

power it with a AC0-DC adapter or batllery 1o get started. The Mega & compatible with
mos! shields designed for fhe Arduino Duemitanove or Diecmila

Spenations Page 2

D A e e Page 6
Eandiuons Page 7

[ﬂ RS radiospanes RaDiONICS A_
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Technical Specification

EACLE fes. 0u00-0e0R2360 ISaIS00R Jeagn 210 Schamanc.

Summary

Microcontrolier ATmega2580

Operating Voltage v

Input Voltage (recommended) 712V

Input Voltage (limits) 8-20v

Digtal 1O Pins 54 jof which 14 provide PWM cutput)
Anaiog Input Pins 18

DC Current per VO Pin 40 mA

DC Current for 3.3V Pin 50 mA

Frash Memory 286 KB of which 8 KB used by boaticader
SRAM aKB

EEPROM 4 KB

Clock ﬁ 16 Mz

Test”

BALETN

2339333 .5

analog pins.

[ RS radiospanes Rapionics A_
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The Avtieo Negalstd can be powersd via he USES conmecton of with @ ealerned power suppfy  The possr sowrce s

sebectud sctormaticdy t-vdlmtﬂﬂmmm*MQM“M-m he
sclipter can Se conrected by pegong & 2 Tmen cenler-poatee g o e toends power jacx Lesds bom e Delery
=an Su naeried 0 e God end Ve on heacders of e POWER comnecas

The bosrd cen cpersis on an sxdsnel suggdy of £ 10 20 sots ¥ sppbed Wih lses Ban TV, however e 2V i may
Sopply s e Gve vols ared B Soued mary e unsletie I usng moee than 12V e woltage 'egator mary owerhasl
arvt damage B bosrd The recommended rngs & 7 & 132 volla

The NMegalSi0 affers bom ol precsding Soasts i that I Soms not uss the FTOE USE o dreer cfip Instesd o
atsus De AUregattll pogranimiet se o UNSE- L sene corverter

The pos prw sre s lolows

* VIN The mpt solage s e Actume bowrd whan s Garg an sxhemed power sosrts (88 opposssd & & sty
Bun he UEE conmecton o offwe reguisied powsr source ) You can supply vollege Beough e e o #
by vUage sm P pOower sk access | ITToLGh Pae e

* BV The regeband power spply used 10 possr e meccconiruies end ot components on e toed. This
Can come efher om VIN vie @0 on bosrd regeldor o Se sppied Sy USIH o ancther regoletat IV waely

* IV A LD sok supply gerscutes By Pw on-bosrd egastor Masrmum cerrend dew 8 50 mA

e OND. Growrd pos

The AT magal=ind das 290 1B of Seah mernary he soneg code (f whech £ K8 & used b Be bostioader), § X8 of
BNAM anal 4 KN of EEPROM Owrveh can De mad and weties v fre LLENOM oy

Ead of e 4 g nh&.mbu--m-m“q -
mwmwul“tﬂnmnnm.w m-
ety (IBCer et ted by Sefeat) of 20 50 Alvrm W ABMN wime BT e apecelied s tane

0 (MO0 w1 (TX); Sl 10 19 K] el 58 (TR Sertet 3 1T () and 18 (TX), Sertal 3 18 (RX) ant
0T Usesl & recsten (0 ared ranaest (TX) TTL st St Pam 0 vl | s ies srweaied e e

External viarrupts: 2 fnterupt 35, 3 Srterrapt 1L 18 eterrugdt 5 18 (nteerupt &) 20 (ndeerupt ) end 31
Ortmerupt 3. Thess pare cun Se Gedgeed b Nigow an mlesupt o & w sabie & g o g sige o »
g = csbie Sen e QUMY PeraTien br dwtads

PWAL 0% 13 Prorechs 800 PN sutpes Wi e aiuiuiiiong st

S 50 (MSO), 8% (MOSIH, 52 (SCK). 53 (58) Thess s mppant BN comumunaaion, whh sougn

mlwh Nardwars. & Ml Curvertly mchitud 0 the AMans weguege [he S prw e sas
st D 1O raster whah s irpecally conpetite ath e Cussslenve el Dwonde

LED 13, Drw & & bl LED snrneind i gptad pon 13 Whes fas pin o HI0M vats. B LED & . whan
o o LOW e ot

FC 20 (BDA] sl 31 (BCL) Suppont T (TWI) comemrscaston g e Sl Sy oosmentston o0 e
Wing wstinte | Note I Ness 508 @ At 0 T sarve Doesen as e 1'C prw 0 Te Dusmderrw

The Mgl hus 18 analog rpats, sech of wivehs provete 10 Ban of reasieton fia 1004 el v ) -ten
Priry onanirs Trors grovest 10 3 vl Bragh o i poastie B hange e Lgaper wnnd of e rage Lng he AREF o arvd
andogiabuimn (| havnan

Thass arw o mugis of st ps o0 T Dl

o AREF Nefwrmnos soliage b e ek mpnie Usesl oot goadociiobaaiag |
* Mosst Brng 1on ow LOW b0 el e rsomsandroins  Toapaunty snsnl 30 bl o seanl ton W aleabis whss
e e arm o e )

EBMW:M_A_
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Communication

The Arouing Megal2S60 has & number of fackies 10r communicaling with @ computer, ancingr Arduno, o
other migroconmolens. The ATmegalSel provwdes four Nardware UARTS for TTL (5V) seral communicaton
An ATmegadU2 on he oad channets one of hese over USE and provides & wiittsal com porm 10 sofware on
Do compuier (Windows machnes will nsed & iof fle. tut 06X and Linux machines will recogniae he board
8 a3 OOM pot auomatically The Amuing SOfwaie InCLGes 3 Seral Moodor which Jlows smple teatual
data 10 be sent 1o and from e board. The RX and TX LEDs on the boand will faah when dala & heng
rauu:ﬂnmﬂm&ﬂmouuuﬁmn“wh‘mhmmm
on pies 0 ant 1)

A SofaanaSanal IRGAry Jows 10f G0Nl COMMUNICINoN on any of e Mega's CigRal pes

The ATmegalSe0 also suppons 12C (TWI) and 5P communication. The Arduing soffearns inchudes a Wre
Beary © Umpity use of the 2C Bus: see e QoLUNQIGILGS 20 e WNg aelalls or datals. To use he A
COMMUNCAON, pledse Lot the ATmegal 560 datasnee!

Froqrammin

The Arduno NegadSE0 can Do programmed with he Arcun softwire (doaninadl For detads e the
iRl and ks

The AtmegalSEl on the Arduno Mega comes frebumed wilh & JoOlolaar el allows you 10 wWicad new
e 10 £ WIlOut Iha Use OF 3N axdernal Nandware PIOgrammer I communcales wnyg the cnginal STKS0O
protocd ((glececcs. Cheadec Siee)

You can §so Dypass e Doctioader and program he micocontiober Brough e ICEF gn.Crout Senal
Programening) header | see (ke Daliucticns e detais

104



Rather hen roqueing a physical press of e resal Dulon Dol an LEioad. the Asduing MegalSE0 =
Sesigned In & way ING Jlows If 10 Be resel Dy SOMeam AN ON & COMNECIed compuler. One of De
hantware flow control ines (DTR) of he ATmegadll s connecied 1o Ihe resat ling of e ATmegal<E0 va a
100 panclaas capactor When T Ine S assemed (hen Ow), Te reset 100 G0gs 100G ercugh © lesel Te
hipg. The Aduing Soffware uses Ihs cacability 10 iow you 10 LPICSD code Dy Simply pressing he wioad
tution in e Arduno environment. Ths means Pal Te Dootoader Can PNave & shonur Iecut as he
Owering of OTR Can De well-LOMNINAies wih T 5t of e Lpoad

Ths setup has other mmplcations. When he .mnnnm%
o Linus, | resats aach Time & connecton is 10 it Pom solware (wa USE) For e Rilowing

o 50, he Doclicader S AAning On he MegadSad. Whik & & progammed 1o ignons malfomed data (Le
ANyINng Desides an Lpicad of New code), § wil INarcept e Trst few Dyltes of QA0S sent 1© e 2o afer 2
CONABCION (S Cpenad If A Shalch rUing on Tl Do MCEves ONe-30e CONBQUIAton o offer S35 when £
sl Slarts, Make Sue DAl e SOMam ol which || communicaies walis 3 second afar cpening e
CONABCION and Defore sendng ha cas

The Mega contiens & Tace INGL can Do Cuf 10 Gisabie e Juls-meet The pads on fter Sate of e ace can
D¢ soldered logeher 10 re-anatile £ IS Gbeled RESET-EN" You may aiso be aie 10 dsatve e 240 /et

Dy connecting @ 190 chm resisior fom SV 10 Me reset Ind: see g S eyl for aetads

The masimem lengih and width of the Megs FCE e 4 and 2.1 inches respectively. wih Pe USE conneccr
S POWRT jach Deyond P Romer dmenson Thres screw Noks #iow P boded © De aached ©
& SaTace o case Note he dalance Detween AN s 7 and 8 s %80 ma (0 167), Aot an swen muligie
of e W00 mil spacng of the other plra.

mw.mmbu WER Mo sheekts desgred for the Decmes or Dusmduncwe

pirs 000 1) e adpcent nd OND s, anaiog wpuss 0 0 5 e power Peader. and
neader e ol » equalent Leatons. Funher De man UART (senal po) & locaied on Pe same pos 0 and
1) 48 ae extomal imemupts O and | (pins 2 and 3 mapociely) 5% & avautie the ICSP header on
Dot e Mega a0t Dusmidanowe / Discmils. Pease note hat 'C is not located 0n the same plas on the
Mags (20 and 21) as the Duambancve | Diecimils (snalog inguts 4 and §)
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Arduino can sense the ervironment by recenang nput fom a vanety of sensors and can aflect s
surrouncings by controlling Sghts, motors, and other actuators. The microcontolier on e boad s
programmed wsing e AMco Qrogamining laoguage (based on g and he Ardunc
deveiopment ervircnment (dased on Plocesiing) Aduno projects can de sland-alone or ey can
communicaie wilh software on unning on 3 computer (e g Fash, Processing, MaxSF )

Arduino 15 a cross-platoform program. You'd have o follow dfferent instructions for your personal
OS. Check on the Aluing Sie for the dest instructions.  Mipolarauno coen'Gude HomeFage

Linux Install Windows Install Mac Install

Once you Nave CoOmMIO0ed LAEEed e ardund DE you can Piug e AsSung 10 your PC wa USE cale

Blink led

Now you're actually ready o "bum’ your
frst program on e arduno toat. To
selec "hink led”, the phwyscal transiason
af the well Anown programming “helo
worid”, select

File>Sketchbook>
Arduino-0017>Examples>
Digital>Blink

Once you have your skecth you'll
see something very dose o the
soreershot on the nght

in Tools>Board setect MEGA

Now you have 1o go o
Tools>SeralPort

and sefect the rght senal port, the
one arduno s altached o

[j RS radiospares nrapionics _‘,g_
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Oimensioned Drawin
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